
          
  

 

Reference Manual  
for Non-Salary (non-grant) Cost Transfers  

and the use of JET  
 
 
 
 

 

 

 

Table of Contents 

 
Introduction Page  1 
Project Background           2 
Accountability (power of Jet)            3 
Definition of a Transfer        4 
Policies and Procedures          5-10 
JET Overview          11 
Use of JET          12-32 
Delegation Agreement Form  33-34   
Resources        35  
Appendices 

Appendix A: JET System Hardware and    36 
Software Requirements  
Appendix B: Menu Command Reference   36-40 

 Appendix C: Toolbar Command Reference   41 
Appendix D: JET Error Messages    42-43 
Appendix E: Uninstall JET     44 
Appendix F: WISDM Username and Password  45 

   
 

 
 
             
 
 
 
            8/25/2010 



     1 

Introduction 

 

Purpose of This Manual 

This reference manual provides detailed information in use of corrective non-salary (non-
grant) transfers and the use of the Journal Entry Tool (JET) to complete the transfer process.   

 

The manual provides a project background, a definition of a corrective non-salary transfer, 
policies and procedures related to non-salary transfers, an overview of JET, detailed 
instructions in the use of JET, copies of the JET authorization form and JET user agreement 
form, and a list of campus resources to help answer any questions that may not be 
addressed in this manual. 
 

 

 

Training and Certification 

Before receiving authorization to use the JET a person must be trained and certified by 
Accounting Services to use the tool for completing non-salary (non-grant) transfers. 

 

Both a JET authorization form and a JET Delegation Agreement form need to be completed 
by a potential JET user and approved by his/her divisional financial officer before attending 
the training course. 
 
Once the training course has been completed and a test work product has been successfully 
passed, the Accounting Services trainer will approve the trainee for access to JET for the 
completion of non-salary (non-grant) transfers. 
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Project Background 

 

In November, 2007 an Administrative Process Redesign (APR) campus survey was sent by 
the UW Survey Center to 10,000 randomly selected campus members.  The open-ended 
survey focused on business services, human resources, information technology, and 
sponsored programs.  Respondents were asked what was working well and what needed to 
be improved. 
 
From the responses the APR-Business Services Process Team did a ranking of the results 
using several criteria (control of process, importance of process, % affected by process, 
expense to continue the process, expense to fix the process, organizational readiness to 
change the process).  The results showed that the “most broken” Business Services process 
to be cost transfers. 
 
In June, 2008 an APR “Corrective Non-Salary Cost Transfer” project team was formed with 
the goal to reduce the amount of time to process a corrective non-salary cost transfer from 
the time the error is discovered until the correction shows up in WISDM (Wisconsin Data 
Mart). 
 
Project statistics included -   

 7100 transfers processed in 2008 (6500 in 2009) 

 transfers totaled $86 million  

 26% were non-grant and 74% were grant 

 average of 29 days for non-grant and 50 days for grant 

 some transfers take longer than average 

 $1.2 million/year, cost of inefficiency & processing 

 
Project findings included –  

 lots of inconsistency (filling out form, reviews)  

 lots of redundancy (multiple checking & reviewing) 

 little sense of urgency 

 lots of handling, sorting, routing, movement, and waiting 

 little agreement on what signatures mean 

 approvals & reviewing may cause delays 

 batching process may cause delays  

 shadow systems have been created (for tracking purposes) 

 centralized validation adds little value 

 no ability to track the location/status of a pending transfer 

 no standards 

 no policies/procedures 

 no training 

 
Project solutions included –  

 write policies & procedures 

 update form & instructions (reduce approvals from 5 to 2) 

 provide training & certification (JET/JRT, policies/procedures, approval definitions) 

 decentralize non-grant data entry (give access to JET/JRT) 

 eliminate validation by Accounting Services 

 improve batching/keying methodology 
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Accountability (power of JET) 

 
It is important for users to understand the power of JET and the responsibility they have for 
ensuring the accuracy of the financial information being entered into JET.  Transactions 
entered into JET are interfaced and posted to the general ledger (SFS).  The general ledger 
is the source of information sent to the Department of Administration and upload to WISDM, 
where is can be viewed by campus.   
 
The user has a responsibility that the data included in their JET entries: 
 

1) meet the criteria set forth in the policy 
2) adheres to the terms of the user agreement 
3) is a valid funding string  
4) corresponds with the level of security given to the user 
5) meets accounting requirements (such as entry must contain equal amount of 

debits and credits) 
 

Transactions entered through JET encounter a number of “checks” prior to being submitted to 
SFS. However, we do not currently have the ability to catch every type of error that exists.  
JET users should recognize this and take the necessary steps to ensure that entries do not 
violate any of the above criteria. 
 
Transactions entered into JET cannot be changed or deleted once they are submitted! 
 
By signing the Delegation Agreement you are accepting all responsibility for your entries. 
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Definition of a Transfer 

 

 Definition 
A Non-Salary Cost Transfer is an after-the fact reallocation of costs.  The 
Non-Salary Cost Transfer form is used to transfer funds/move 
expenditures from one fund, department, project, account, amount, etc. to 
another to ensure the accuracy of the general ledger and data integrity.  
Non-Salary costs are supplies, consultants, travel, equipment and other 
non-payroll expenditures. 

 

 Example of Acceptable Transfer 
a) Correction of a clerical error 
b) Reallocation of expenses where multiple accounts benefited 
c) Reallocation of shared resource costs 
d) Transfer of costs to divisional discretionary funds  

 
 

 Transfers not allowed 
1)       Transfers using balance sheet accounts 
2)       Transfers using revenue accounts 
3)       Transfers across divisions (should be sent to Accounting Services after 
            receiving approval from the other division) 
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Policies and Procedures 

 

 Policies and Procedures 
This document applies to non-grant fund non-salary cost transfers only.  
 

 There are two phases to the transfer process--the preparation phase and 
the review phase.  The preparer often has discovered an error or has 
been instructed to move funds and as a result initiates the transfer 
process.  The person who prepares the cost transfer may be the first 
approver (comparable to the approver role in e-Reimbursement).   

 
 The review phase entails a second person (comparable to the auditor role 

in e-Reimbursement) to review and enter the transaction into the Journal 
Entry Tool (JET).  The preparer is usually at the department level, but may 
be at the division level or Accounting Services.  Who does it is generally 
determined by who found the error and who has the knowledge required 
to make the correction.  Separation of duties is important; however, in 
small departments one person may serve in all three roles.  

 
 The professional diversity of the personnel who prepare and process 

transfers should be recognized.  Establishing a clear expectation about 
what should happen at each step of the process is important.  One of the 
major goals of this change is to eliminate redundancy.  For smaller 
divisions one individual might perform all three roles. 

 
 Training and certification in use of the JET is required for all approvers. 

The respective division must also sign a Delegation Agreement 
authorizing the individual to act on behalf of the division in the preparation 
and submission of non-salary cost transfers using the JET. 
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Definitions of transfer terms: 

 

 Necessary: Original cost applied must be absolutely essential to achieve a 
certain result.  Transfer is necessary to have this cost applied to the 
proper funding. 

 
 Reasonable: The nature of the original cost and the subsequent transfer 

reflects the action that a prudent person would take under similar 
circumstances.  “If it were published on the front page of the Wisconsin 
State Journal, would that be okay with you?” 

 
 Allocable: A cost is allocable if goods or services involved are chargeable 

or assignable in accordance with the relative benefits received by the 
funding.  In order to be allocable a cost must be treated consistently in like 
circumstances. 

 
 Consistent: Free from variation or contradiction from standard university 

business practices. 
 
 Permissible: Allowed under university policies and state law. 
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Roles and Responsibilities in the Non-Salary Cash Transfer Process  

 
 
 

Preparation 
Phase 

Review 
Phase 

Responsibility Preparer 
First 

Approver 
Second 

Approver 

1. Generate form    

a. Know policy    

      b.  Resolve problems    

      c.  Update form based on approver’s 
     feedback 

   

2. Confirm that:    

a. This transfer is necessary    

b. This transfer is reasonable    

c. The expense is allocable to the funding 
source to which it will be charged 

   

d. This transfer is consistent with standard 
university business practices 

   

e. This transfer is permissible, given 
university policies 

   

3. Verify that:    

a. The form is complete    

b. The information on the form is correct    

c. The source to which the expense is being 
transferred has sufficient funds to cover 
the expense 

   

d. The form is not missing any signatures 
from the previous step 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



     8 

Additional responsibilities for each role: 

Role Responsibilities 

Preparer  Know and understand the UW cost transfer policy  

 Generate the transfer request form  

 Seek support in resolving difficulties with generating transfer requests  

 Improve the accuracy of transfer request forms in response to feedback from 

approvers when requested to do so  

First 

Approver 

 Know and understand the UW cost transfer policy 

 Determine whether explicit approvals are required from the "owners" of non-

sponsored funding sources, and obtain the explicit approvals when necessary  

 Route each transfer request form to the second approver  

 Provide feedback to preparers when the accuracy of transfer forms does not 

meet an acceptable standard of quality  

 Provide suggestions to preparers regarding strategies for improving the 

accuracy of transfer forms  

 Recommend eliminating the authorizations for preparers whose forms do not 

meet an acceptable standard of quality despite feedback and quality 

improvement efforts  

Second 

Approver 

 Know and understand the UW cost transfer policy 

 Attend training in the non-salary cost transfer approval roles and 

responsibilities  

 Verify that the transfer request form has been signed by the first approver, 

and return it to the first approver if it has not  

 Forward the transfer request to Accounting Services if the division chooses 

not to enter its own non-sponsored transfers directly into JET  
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Records Retention 
 
Non-Salary Cash Transfers fall under the following record retention schedules-- 
http://www.uwsa.edu/gc-
off/records/schedules/06.20.2007.UWS.General.Schedule.Fiscal.Accounting.Records.pdf.  
Non-salary cost transfers are general ledger transactions and FISC600 for journal entries 
applies: 

 
Records include all supporting documentation for journal uploads or entries into the 
Shared Financial System General Ledger These may include, but are not limited to, 
internal transfers (chargebacks), payment transfers, revenue transfers, budget 
transfers, and budget entries for projects.  Also included is documentation supporting 
the allocation of purchasing card expenditures, as well as supporting documentation 
for project budgets.  The original source document retention time period is the fiscal 
year of creation + and additional 6 years, and thereafter destroy.  Duplicate documents 
should be destroyed when no longer needed.  Do not retain duplicates longer than the 
original record.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.uwsa.edu/gc-off/records/schedules/06.20.2007.UWS.General.Schedule.Fiscal.Accounting.Records.pdf
http://www.uwsa.edu/gc-off/records/schedules/06.20.2007.UWS.General.Schedule.Fiscal.Accounting.Records.pdf
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New Cost Transfer Request (Non-Salary) 
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JET Overview 

 

What is JET? 
 
JET is short for Journal Entry Tool.  This decentralized desktop application was developed by 
Madison Campus Accounting Services and the Division of Information Technology to 
facilitate the entry of accounting transactions needed across campus into the Shared 
Financial System (SFS).  JET was designed to be less complex and provide greater 
safeguards than entering transactions directly into SFS.  To accomplish this JET has many 
built in features that will help to ensure the accuracy of the journal such as chartfield 
validation, funding string editing, unbalanced entry check and security authorization 
validation.  Problems are identified and must be corrected in order for the journal to be 
submitted to SFS.   
 
JET transactions are uploaded to the SFS system where they are posted and subsequently 
interfaced to WISDM using the current overnight processes.  Basically, JET entries submitted 
today will be viewable in WISDM tomorrow.   All fields populated in the JET application are 
either searchable or viewable in WISDM.   
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Use of JET  

 
Authorization and Installation 
 
Prospective Non-Salary Cost Transfer JET users will be required to do the following before 
being granted access to the JET application.  
 

 Attend the Non-Salary Cost Transfer training course 

 Complete the Delegation Form (Forward to Business Services) 

 Complete the Security/JET Access Form (Forward to Accounting Services – Susie 
Maloney) 

 
Once the above have been completed and Accounting Services has received the 
Security/JET access Form, they will send you an e-mail with the following link: 
http://wisdm2.doit.wisc.edu/JournalEntry/JournalEntry.application 

 
The link will allow you to: 

 
1. Verify that you have the correct web browser, Windows Edition, and .NET Framework 

installed on your PC.  Refer to Appendix A for additional information. 
 

2. Download the JET Application to your desktop to complete the installation. 
 
 

Launching JET 
 
Once the user has successfully installed JET on the local (client PC) the application can be launched 
by following the following steps: 
 

1. Go to the Windows Start Menu  
 

2. Choose “All Programs” 
 

3. Choose” UW Division of Information Technology” 
 

4. Choose “Journal Entry Tool” 
 

http://wisdm2.doit.wisc.edu/JournalEntry/JournalEntry.application
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5. The login dialog box appears. 
 

 
 

The user logs into JET using their classic WISDM login username and password.   
 
(Note:  The WISDM login username begins with “MSN” and the password is unique.  
See Appendix F for instructions on how to change your WISDM password.) 
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Journal Entry Tool (JET) Basics 
 

 
 

JET consists of a main window and a number of other window panes that are important to become 
familiar with. In the center of the window you will see the Entry Grid where the detail information of 
the journal is entered.  This entry grid can be modified by the user to rearrange columns, change the 
view from transaction to journal mode (single column debit and credit entry, or double column entry), 
view in multiple lines or by a single line, and change grid lines and colors. 
 
At the very top of the main window is the Menu Bar. This acts exactly like any Windows application's 
menu. Program commands are stored in the menu drop downs. Some commands can be invoked by 
a keyboard shortcut (such as CTRL+S to save a document) whereas others do not have this function.  
Directly beneath the menu bar is the Toolbar which provides icons that are buttons for quick access 
to menu commands. Like a keyboard shortcut, these can help save you time looking through a menu 
for a specific command. If you are unsure what a toolbar button does, hover over it to get a tooltip 
explaining what it is.    
 
To the right of the entry grid is the Task Pane. This pane is resizable and gives you quick access to 
some important operations that you must perform on a journal prior such as editing a single line, 
editing the entire journal, balancing the journal and submitting the journal to SFS.  The Status Bar 
gives you information on which current line number you are on within the journal, a currently running 
operation such as uploading, editing, submitting to SFS, or the current operator. 
 
To the bottom of the entry grid is the Errors List Pane. This pane is also resizable and will show the 
current errors that a process (such as edits) has returned about your journal.  
 
 

 

Entry 

Grid 
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Creating Manual Journals Using JET 
 

Now that you've launched JET, you're ready to create your first journal entry. You can use JET to 
manually enter journal lines (transactions) or later in the training guide, you will learn how to import a 
file using an .XLS or .TXT file.    

 

Step One – Creating New Journals 
 

To create a new journal in JET you may use any of the following options.  From the File Menu, select 

New Journal, use the shortcut option by pressing CTRL+N, or click on the New Journal  icon on the 
toolbar. 
 
The New Journal dialog box will pop-up prompting for information on which type of journal transaction 
you wish to perform.   
 

 

 
 
Select the “Non-Salary Cost Transfer” journal type by double clicking on icon.  
 
 
 
 
 
 
 
 
 
The New Journal dialog pane will also ask for: 
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 Business Unit (Default) 
This field defaults to “UWMSN” for Madison Campus.  This is the same Business Unit as 
your WISDM user profile. 
 

 Journal Date (Default) 
The journal date will default to today’s date or July 1st for the 13th accounting period.  It will 
change every time you open the file until you have submitted the journal. 
 

 Fiscal Year (Default) 
The fiscal year defaults to the current fiscal year.  It will not change over to the new fiscal 
year until JET is set to run for the next fiscal year.  This allows final year-end processing in 
July. 

 

 Description – (Required) 
The Journal Header Description will be a required field that you will manually key your 
Department Name and a phone number of the person who will be responsible for 
answering any questions related to the transaction.  This field appears in WISDM and is 
intended to assist the recipient of the charges understand what the charges are for and 
who to call if there they have questions.  You have up to 30 characters in this field. 
 

 Trans Ref - Optional 
 
After you complete the information, press OK.  JET will create a new valid GL journal grid for your 
journal and set up a template for your work. At this time, the journal has no detail transaction lines and 
is ready for you to either manual enter data or import a file.  
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Quick Guide - Creating a New Journal 
 

o Select File, New Journal from the Menu Bar 
o Use Shortcut by pressing CTRL+N 

o Click New Journal   from the Tool Bar. 
o When New Journal Dialog box appears select the Non-Salary Cost Transfer icon 
o Click “OK.” 
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Step Two – Entering Transactional Detail Manually 
 
Now that you have selected the appropriate journal type, you can start to type transactions into the 
main grid. The main grid will always have its last line available to add a new row of data (signified by 
the asterisk symbol (*) on the row header).  
 
To start a new journal transaction, simply click on the cell with the (*) and start typing the appropriate 
information into the row such as the Dept ID, Fund Code, Program Code, Project ID, Account, Class 
Field, Amount, Description (Required), Journal Line Reference, Reference, Voucher #, and Invoice #. 
 

Guidelines on Use of Non-Chartfield Fields in JET: 
 

JET Field Names WISDM 
Field Names 

Field 
Length 

Guidelines on 
Use for Cost Transfer (Non-Salary, 

Non-Grant) 
Activity ID This field is 

not indexed 
or 
searchable in 
WISDM. 

2 Not used on Cost Transfer Form 
(Non-Salary, Non-Grant). 

Jrnl Line Reference Jrnl Line Ref 10 Not used on Cost Transfer Request 
form. Cost Transfer Form (Non-
Salary, Non-Grant). 

Description (Reason for 
transfer) 

Description 30 Required field. 
Must enter a brief reason for the 
transfer in this field.  Must be as 
complete as possible (e.g. “to 
transfer funds” is not acceptable). 

Reference  PO,  
Purchase 
Order ID 

10 Optional field.  Should contain 
original PO Number for PO payment 
transfers. 

Voucher No Voucher ID, 
Vchr ID.  
This field is 
indexed and 
searchable in 
WISDM. 

10 Optional.  Should contain Original 
voucher ID used for non-PO 
payments, or original 
transfer/internal billing journal ID. 

Invoice No Invoice No.  
This field is 
not indexed 
or 
searchable in 
WISDM. 

12 Not used on Cost Transfer Request 
form. Cost Transfer Form (Non-
Salary, Non-Grant). 
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Basic JET Navigation and Editing Tips: 
 

Action Result 

TAB Moves to the next cell to the right. 

ESC Cancels Editing or Undoes the changes in current cell. 

Arrow Keys Moves from Cell to Cell or Row to Row 

Edit Cell Highlight cell by clicking in it and start typing.  You may 
also press F2 to begin the edit process on a cell. 

Add New Line Down arrow to the next available line.  A new line will 

show with an * or use the  icon on the toolbar. 

Undo (CTRL+Z) Undoes the last command such as adding a new line, 
deleting a line, or inserting a line. 

Insert Line  (SHIFT+INS) Highlight Row you wish to insert a line directly after and 
either select from the Menu Bar, Edit -> Insert Line, or 
use the shortcut of SHIFT+INS.  

Delete  Row  (CTRL+SHIFT+DEL) Highlight a cell on the row you wish to delete (or select 
the entire row) and then press the delete key on your 
keyboard. You can also delete a row by clicking the 

Delete Row  icon on the toolbar. 

Current Line JET refers to the current line with a black arrow on the 
row header.  The current line is also the line where the 

current cell focus is.  See the  icon on the toolbar. 

Uppercase All fields in JET are in uppercase automatically (except 
for line description).  There is no need to press the shift 
or caps lock key on fields such as project ID. 

Jump to Specific Line Number Type the line number in the text box in the  icon on 
the toolbar. This area of the toolbar also gives you VCR-
like controls for navigating through the records. 

Hiding Panes To make more room on the grid, you can hide the Task 
Pane and the Error List.  To hide or to show it, look in the 
View Menu.  As a rule of thumb, anything affecting the 
presentation of the data or the application itself will be in 
the View menu. 

Rearrange Columns Click on a column header and hold and drag to its new 
position by either moving to the left or to the right.  When 
column header is positioned where you want it, let go of 
the mouse.  The new arrangement will be preserved 
across application uses. 
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Hide/Show Columns Use the Choose Columns command from the View 

Menu.    This will give you a 
dialog enumerating all possible columns.  
 

 
 
Check on visible columns, check off columns you don't 
wish to see.  The visibility of a column does not affect 
whether the data will be validated or uploaded but does 
affect which columns will be exported or printed.  
 
You may also right-click on a column header to get a 
menu that will allow you to immediately hide the column 
or bring up the Choose Columns dialog box. 

View Mode For manual entry, it is sometimes easier to use 
debit/credit rather than a single amount field.  JET has 
two modes of displaying dollar amounts - Transaction or 
Journal View Mode.  
 

 Transaction mode displays the amount field as a 
single column and a negative amount signifies a 
credit. 

 Journal mode displays the amount in one of two 
columns (debit or credit).  The numbers entered 
while in Journal mode have their signs ignored 
and it is the column that later dictates the sign.  

 
You can change the View Mode by selecting it from the 

View menu or by clicking on the View Mode  icon on 
the toolbar button.  Your choice will be saved across 
application uses.  
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Copy/Move Line To copy a row into a new one, click on a row header and 
drag it while holding down the shift key.  You will copy 
the entire line to the new location you drop it at.  You will 
notice the mouse cursor change when doing this 
procedure (it will have a little box attached to it with a 
plus sign which indicates copy.)  If you don’t hold the 
shift key, it just moves the line rather than copying it (and 
no plus sign appears.) 
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Manually Entering Data Review: 
 

 To Manually Enter Data in the Grid begin keying in the * row, starting with the DeptID 
information. 

 Continue to key data until line is complete.  Move to the next line by either using the down 
arrow key, or by hitting tab. 

 Continue to key until all data is entered. 
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Step Three – Perform Edit Validation and Balance Checks 
 
After you have completed entering your transaction detail, you must check the entry for several items.  
JET will not allow you to upload a journal to SFS that contains any of the following problems:  
 

 Accounting Edit Errors 

 Balance Problems 

 Authorization Problems 

 Other Journal Specific Problems 
 
Accounting Edit errors are based chartfield and combo edit rules that ensure that the chartfields are 
accurate both alone and as a funding combination.  Any line within a journal that has a funding string 
which does not pass edits will prevent the entire journal from being uploaded to SFS. 
 
If the Department of Administration (DOA) deems an account inactive, the journal will not pass edits. 
 
In Transaction Mode, your journal's amount column must sum to zero.  When in the Journal Mode, 
your debits must equal credits.  If these requirements are not met, the journal is not balanced properly 
and cannot be submitted to SFS. 
 
Depending on your WISDM security privileges, you may not be able to record transactions for 
protected departments.  This issue relates to your authorization and could create problems uploading 
the journal to SFS. 
 
Other journal specific problems may arise depending on the type of journal transaction you are doing. 
 

Editing your Entry 
 
To invoke edits, you can either click on the Task Pane's Edit Row or Edit Journal Button.  Both of 
these options are also available in the Journal Menu. 
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The Edit Row function will only check the current row and it is intended to be a quick check when 
manually entering data. 
 
The Edit Journal function however, will check the entire journal for errors.  The edits are performed in 
batches by grouping the transactions in a series of 50 lines each until the entire transaction has been 
edited.  This process can sometimes take a long time (minutes) depending on the size of the 
transaction.  The current status of the process is reported on the Task Pane in the Status area.  
 

 
 
You can cancel the Edit process at any time by pressing the cancel button in the status area.  
However, the process will finish the current lot of 50 before cancellation actually occurs.  Once the 
edits process has completed successfully, any errors found will be listed in the Errors List pane at the 
bottom of the main window. 
 

 
 
 

 

 
 

All lines which contain errors will have a small exclamation point icon (  ) on their row header to 
signify that the row is in error. Hovering over the icon gives a tooltip with all error messages for the 
line.  You can either double click a line in the errors list to highlight the offending journal line in the 
entry grid or you can go directly to the line indicated.  
 
All corrections must be made prior to submission to SFS.  If the entry contains errors that cannot be 
solved at the current time, you may save the entry and return to it at a later time.  This procedure is 
covered later in this document under “Saving Work.”  
 

 
See also: Appendix D:  JET Error Messages  

 

Indicates row has edit errors that must be corrected. 
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Balancing your Entry 
 
On the Task Pane, click “Balance Check.”   
 

  
 
 

Doing a balance check involves the same procedure as the edits, except you click the Balance Check 
button on the Task Pane.  This option is also available from the Journal menu.  If there is a problem 
with the balancing of the journal, an error will appear in the error list.  The error will identify whether 
the journal is unbalanced on the debit or credit side and indicate how much it is unbalanced.    
 
Journals must be balanced prior to submitting to SFS.  
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Step Four – Submit Journal to SFS 

 
Once the journal has completed the editing and balancing process, it is now ready to be uploaded to 
SFS.  Click the “Submit to SFS” button on the Task Pane to being the process.  This option is also 
available in the Journal menu. 
 
This process will first ensure that you have completed both the editing and balancing steps correctly.  
Note: it is possible to invoke the “Submit to SFS” button at any time, however, the process of editing 
and balancing will still occur.  If any errors are still pending, the process will halt and wait for you to 
make corrections.  Once errors have been corrected, press Submit again to restart.  This process can 
be done as many times as necessary in order to solve all errors within journal. 
 
The submit process will upload batches of journal lines until all are written to the database at which 
time a finalizing step will occur.  Once that step completes, the journal will have been successfully 
submitted and you will receive a confirmation message.  
 
At this time you may wish to print out documentation from JET.  This procedure is covered later in this 
document under “Printing.”  
 
You may now either exit the application or begin another new journal. 
 
To Exit the application, choose the Exit menu option from the File Menu or click the standard window 

close button  on the window.  If you have not saved the journal to a .JET file, you will be prompted 
to do so if you wish.  
 
You should always close JET when you are finished with it to prevent any unauthorized use of the 
application, especially if you share your PC with other unauthorized users.  
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Importing Excel or Text Files into JET 
 
Often you will have a file that contains transactions from another system or perhaps were entered 
using Microsoft Excel. JET can import some of these files if they are in a recognized format.  
Importing can be performed after a new journal has been created.  
 
JET will recognize two types of files, Text and Excel.  Text files are flat files that are usually computer 
generated by external billing systems in preparation to be uploaded to SFS.  These files have a fixed 
length line per transaction and fixed column inputs on each line. Excel files have a similar layout but 
they use Excel rows and cells to delimit data.  Consult the Text and Excel file format specifications 
document if you are interested in generating these file types for importing to JET.  The document is 
located on the Business Services Website at: 

http://www.bussvc.wisc.edu/acct/policy/processing/703polacnsptnongrant.html  
 

 
To import a file, follow Step 1 – Opening a New Journal from the Manual Journal procedures above.  
Once you have the new journal opened, you may select from the File Menu, Import and then select 
from the sub-menu either the Text or Excel file importer option.    
 

  
 
You must specify where the file is located and the name of the file. 
 

http://www.bussvc.wisc.edu/acct/policy/processing/703polacnsptnongrant.html
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JET will then read the file and extract all transactions from it and load it into JET.  If there are any 
problems with the file at all, JET will issue an error message and halt the import process.  You must 
fix the file before import is possible.  Note: JET importers are quite robust and will try to import even if 
the file isn't 100% correct, but this is not always possible. 
 
After importing a file, you are free to add or change lines directly in the grid within JET or you may 
proceed directly to the editing, balancing and submission steps.  You may notice that JET importers 
trim and uppercase all fields and so your source data may change a little.  
 
Follow the same steps as listed above in the Manual process to complete the process. 
 

 
 
Additional Application Features 
 
In this section you will find additional JET application features to assist you with your transactions.  
Some of those features include: 
 

 Saving your Work 

 Chart of Accounts 

 Applying Default Funding 

 Adding Cash Offsets 

 Grid Customization 

 Other JET Features 

 
 
 
Saving your work as a .JET File 
 
At any point during a transaction you may save the journal by selecting Save from the File Menu, by 

using the shortcut option of CTRL+S or by clicking on the  icon from the Tool Bar.  The journal 
does not have to pass edits or be balanced to save it. 
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Saving a journal refers to storing your current work in a .JET file.  JET files are the native file format to 
JET and are not intended to be read by any other application other than JET.  This format is to JET 
what .DOC or .XLS is to Microsoft Office. If you need to suspend your work on a journal, saving to 
your local disk is a good idea to prevent loss of data.  JET files also allow you to share a work-in-
progress journal with another user as long as they have the JET application. 
 
Since this is just a regular Windows file, it can be placed on a network drive or attached to an email. If 
another user opens the file, they will assume control of the file and become the operator.  JET 
prevents two of the same exact journal from being uploaded, but it is important that your office has 
workflow policies for JET when it comes to sharing JET files and performing uploads. 
 
 

 
 
 
 
Saving your work as an .XLS or .TXT File 
 
At any point during a transaction you may save the journal as either an Excel or a Text file by 
exporting the file and saving it on either your local PC or on a network drive.  This file may also be 
attached to an email and worked on by another user and later imported back into JET. 
 
To export to either Excel or as a Text file, select from the File Menu, Export.  Choose either the Text 
File or Excel File.  Specify where you would like the file to be saved and the file name. 
 
Once you save your file to Excel or Text, the file then can be imported back to JET at a later time by 
anyone who has access to both JET and the file.  Follow the procedure on how to import a file from 
above. 
 

Using Chart of Accounts 
 
In order to help you enter and correct transaction funding, JET provides a tool called Chart of 
Accounts (COA) that provides insight to the proper funding for a transaction.  The Chart of Accounts 
represents the proper chartfield combinations for the SFS general ledger.  Specifically, the COA will 
show Fund Code, Dept ID, Project ID, and Program Code combinations.  
 
You can choose to open the Chart of Accounts from the View menu, by using the shortcut 

CTRL+SHIFT+C, or by using the  icon on the Tool Bar.  COA is another window pane in the 
application similar to the Task Pane or Errors List.  
  
Once the COA is open, you can put focus on any transaction line in your journal and the valid fund 
code, dept ID, project ID, and program codes for the line will appear in the COA window's main grid. 
In order to narrow down to the appropriate combinations, the dept ID or project ID entered on your line 
will be used as a filter.  If project ID has been entered on your line, it will override the department and 
provide valid combinations for the project in the COA window.  If project ID is blank and dept ID is 
entered, dept ID will then be used. If neither dept ID nor project ID is used, COA will not report any 
data. 
 
As you move from line to line in the grid with the COA open, it calculates the correct combinations for 
the line you are on.  
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COA also provides two handy buttons that can get the proper funding into your grid.  The Copy to 

Current Line  button will take the selected COA row and copy that funding into the 
current line on your grid.  
 

The Copy to New Line button  will make a new row in your grid and copy the 
selected COA row to that new journal line.  If your dept ID or project ID returns more than 100 
combinations, only the first 100 are displayed at this time.  
 

 
 
There are currently some limitations with COA.  These include: 
  

 Only 100 combinations are returned at any given time. If a chart field value has more than 100, 
only the first 100 are returned.  

 COA is only available to UWMSN journals/lines at this time.  

 Large pooling projects such as UWMSN 101A000 do not return any combinations because 
nearly all DeptIds are valid combos.  

 
Advanced Tools 
 
Under the Tools menu, you will find some tools that will perform an advanced and potentially time-
saving function on a journal.  JET contains built-in tools for Reversing a Journal and Reversing a Line.   
 
Reverse Journal 

 This tool will take the entire journal and reverse all dollar amounts in it (in other words, swap 
debits and credits).  This tool is convenient when you want to make a journal that "backs out" 
a previous journal line for line.  Because this operation impacts the entire journal, you are first 
asked if you really want to perform this action.  A subsequent use of this tool will undo your 
previous operation.  

 
New Reversed Line 

 This tool will take only the current line you are working on and create a new reversed line 
below it.  If your current line is a debit, it will create the appropriate credit to balance the 
previous line and vice versa. 

 
This option is not a highly used feature and should always be used with extreme caution. 
 
Only the descriptive columns of the previous line are copied.  It is assumed that you will provide the 
funding fields yourself.  This tool has a convenient keyboard shortcut (CTRL+R).  
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Application Options and Customizations 
 
There are a few aspects of JET that can be customized and saved across application usages.  The 
Options dialog available from the Tools menu allows you to adjust a few of these options.  
 

Customizing the Grid 
 
Here you can customize how the grid looks on your version of the application.  The following options 
can be set: 
 

Option Result 

Grid Lines Single - True Grid View 
SingleVertical – For Vertical Lines Only 
SingleHorizontal – For Horizontal Lines Only 
None – No Grid Lines At All 

Background Colors You can choose from a pre-selected list of colors on how the 
lines in your grid will appear. 

Font Colors You can choose from a pre-selected list of colors on how the 
fonts/text in your grid will appear. 

Show Line Numbers Check “ON” to see a number on every row header.   
Check “OFF” to see nothing. 

Restore Defaults You can restore defaults by clicking on “Restore Color 
Defaults” 

 
 

 

Restore 

Defaults 
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Printing 
 
NOTE THAT IF YOU DO NOT PRINT THE JOURNAL DOCUMENTATION AT THE TIME 
YOU SUBMIT IT TO SFS YOU CAN NOT GO BACK AND PRINT IF YOU START A NEW 
JOURNAL 

 
Here you can setup print options and how the pages will appear when you print a journal. The 
following options can be set:  
 

Option Result 

Include Page Numbers Check “ON” to see page numbers at the top of each printed 
page. 

Include Title Check “ON” to see the Journals Title (GL Journal ID) at the top 
of each printed page. 

Print error lines only Check “ON” to see only lines that have errors in print outs.   

Orientation Select either Portrait or Landscape paper orientation 

Margins Adjust the paper margins in inches or fractions of inches.  
Margins can be up to 3”. 

 
You can also at any point print a journal by using the Print command from the File menu (or CTRL+P).  
 
Print Preview is also available to view what it will look like when printed. 
 
In order to see edit errors on a report, you must run edits first and they must be visible in the Errors 
List window pane in order to be printed out.  
 

Other Application Options 
 
Each time you close JET, the application will save all your options so that the next time you use the 
application, it will remember your choices to provide a better customized experience for you.  The 
following items are saved:  
 

 All user options from the Options dialog box 

 Main window layout, position, size, and maximized states 

 Whether the errors list, task pane, or chart of accounts is visible or not and their sizes 

 Your editing View mode selection - Transaction or Journal  

 Your current column layout, positions and visibilities 

 The last accepted default funding source you inputted into the Default Funding Dialog 
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Delegation Agreement Form 

 

UNIVERSITY OF WISCONSIN – MADISON 
 

Accounting Services 
21 N. Park Street, Suite 6101 
Madison, WI  53715 
 

 
 

Delegation of the use JET (Journal Entry Tool)/JRT (Journal-Transfers) 

 for Non-Salary (non-grant) Transfers to 
 

_______________________ 
(User Name) 

 
 

_______________________ 
(Division/Department) 

 

by 

 

University of Wisconsin - Madison Accounting Services Department 
(hereafter referred to as "Accounting") 

 
 
 

I.   Delegation Authority 

 

The University of Wisconsin – Madison Accounting Services Department delegates to the user designated above 

the authority to use JET for the entry of corrective non-salary, non-grant (any fund except 133 and 144) 

transfers.  In order to receive this delegation authority and gain access to the JET/JRT software the user must 

have completed a training course that provides JET/JRT user certification at the successful completion of the 

course.   

 

A non-salary cost transfer is an after-the-fact reallocation of costs.  A non-salary cost transfer is used to transfer 

funds/move expenditures from one fund, department, project, account, amount, etc. to another to ensure the 

accuracy of the general ledger and data integrity.  Non-salary costs are supplies, consultants, travel, equipment 

and other non-payroll expenditures. 

 

Examples of typical circumstances in which cost transfers are allowed: 

e) Correction of a clerical error 

f) Reallocation of expenses where multiple accounts benefitted 

g) Reallocation of shared resource costs 

h) Transfer of costs from divisional or discretionary funds to another 
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This agreement is in effect until superseded by a subsequent agreement signed by both parties or until 

terminated in writing by the Division or Accounting.  The agreement will be routinely reviewed by both parties 

to insure continuity and the accuracy of the responsibilities for the respective parties.   

 

Access to JET/JRT can be removed at any time for any inappropriate use. 

 

 

II.  Responsibilities 

 

A. By signing the delegation agreement, the user agrees to the following responsibilities (please check): 

    Keep my login and access to JET/JRT confidential 

    Use only my login for access to JET/JRT 

    Use JET/JRT for only corrective transfers 

    Use JET/JRT for only non-salary transfers 

    Use JET/JRT for only non-grant transfers (any fund except 133 and 144) 

    Create transfers for only the division(s) for which I am responsible  

    Use appropriate funding for all transfers 

 

B.  Division agrees to process non-salary cost transfers under this agreement in accordance with State laws and 

regulations and with DOA, UWS, and UW-Madison accounting policies.  This includes the Wisconsin Statutes 

and Administrative Code, Financial Policy and Procedure Papers, UWS Pre-Audit Manual, and internal policies 

and procedures of Accounting Services. 

 

C. Accounting will periodically perform post-audits and issue an opinion on the Division’s compliance with 

the terms of this agreement through the use of statistical sampling procedures, and such other auditing 

techniques as are deemed appropriate. 

 

D. Accounting will issue manuals, procedures and conduct training for Division personnel.  Accounting will 

provide policy and procedure updates in a timely manner.  The Division will insure that the proper personnel 

attend such training and participate in development of policies and procedures. 

 

E. Accounting will be available to work with the Division in giving solutions for cases requiring special 

attention due to unique situations or unusual circumstances. 

 

 

 

III.    Approvals 

 

 

FOR:  Accounting Services   FOR:  Division  

 

 

_________________________   ______________________________ 

Jan Richardson     (User) 
Associate Director, Accounting Services     

Date______________________   Date__________________________ 

 

 

       ______________________________ 

       (Division/Dean’s Office)  

   

       Date__________________________ 
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Resources 

 

 “Reference Manual for Non-Salary Cost (non-grant) Transfers and the use 
of JET” 

 

 

 “Non-Salary Cost Transfers” web- site at  
http://www.bussvc.wisc.edu/acct/policy/processing/703polacnsptnongrant.
html 

 
 

 Contact:  Veronica Olson, Accounting Services at 
volson@bussvc.wisc.edu  

http://www.bussvc.wisc.edu/acct/policy/processing/703polacnsptnongrant.html
http://www.bussvc.wisc.edu/acct/policy/processing/703polacnsptnongrant.html
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Appendices 

  

Appendix A: JET System Hardware and Software Requirements 

 
 

JET was developed with the Microsoft .NET technology.  In order to use JET, a user’s (Client) PC 
must meet the following software and hardware requirements: 
 
   

 .NET Framework 3.0 or later*  

 Internet Explorer 6.0 or later (required only for the initial download)  

 A valid WISDM account with JET privileges (WISDM data view account name and password). 
o [Note for Windows Vista users: your Windows edition already ships with .NET 

Framework 3.0 and IE 7 - no additional software is required to run JET!]  

 Microsoft Windows XP SP2, Windows Server 2003, or Windows Vista (any edition).  
o Note: Windows 2000 will not work.  This also means other operating systems do not 

work, such as the Apple Macintosh.  
 
*You can install the Microsoft .NET Framework 3.0 via Windows Update as an optional software 
update or you can install it directly from Microsoft Download Center.  The .NET Framework is a 
necessary runtime Windows component required for JET operation (similar in theory to the Java 
runtime system), and is fully supported by Microsoft as a Windows component.  Installing .NET 
Framework 3.0 requires Windows Administrator privileges.  
 
 

Appendix B: Menu Command Reference 
 
 

This section will explain what each Menu option does within JET. After each menu name, if there is a 
keyboard shortcut, it is listed in parentheses.  

 
 

File Menu 
 

Menu Command Result 

New Journal  (CTRL+N) This invokes the New Journal dialog box and is the first step to 
creating a new journal.  The New Journal dialog will ask you to 
select a journal type, and enter some basic Journal Header 
information such as the Description and Trans Ref.  This 
information is optional, but you are advised to use it.  You will 
be prompted to save any current work before this command is 
invoked. 

Open  (CTRL+O) This opens the Open JET File dialog asking for a .JET file to 
load.  This is a standard Windows file open dialog.  You will be 
prompted to save any current work before this command is 
invoked. 
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Import This is the menu header for a submenu which lists all possible 
importers for the current journal types.  This menu command is 
not available until a new journal has been created (in order to 
establish the journal type).  The sub-menu to the right of this 
command will list each possible importer.  Each importer opens 
the Windows open dialog box that will prompt you for a file to 
import.  If no importers are available for your journal type, this 
command will be disabled. 

Save  (CTRL+S) This will save the current journal to a .JET file.  If you are 
invoking this command for the first time since creating a 
journal, you will be prompted for a file name.  Subsequent save 
commands will use the previous file name to save the file 
(overwriting the previous copy). 

Save As This saves the journal to a new .JET location and begins a new 
save filename.  Use this command to save a copy of the 
journal to a different .JET file. 

Export This command opens a submenu that shows available 
exporters.  Currently, the MS Excel XLS exporter is all that is 
available.  An exporter is different from a save because it 
translates the journal from the native format to the format of the 
exporter.  The Excel exporter is intended to give you an Excel 
.XLS document that represents your current view of the 
journal.  Note that your column layout affects the exporter's 
layout so you may need to adjust your columns first before 
exporting.  The Excel exporter generates Excel documents 
readable in any version of Excel since 2000. 

Print Preview This command will show a dialog that will generate a preview 
of the journal when printed.  Use this command to see a 
printout before going to paper. 

Print  (CTRL+P) This command will open the standard Windows print dialog 
where you can submit a print job to any printer installed on 
your PC. 

Exit Exit the JET application.  You will be prompted to save any 
pending work.  Note: since you have launched the JET 
application from WISDM, WISDM may still be running in 
another web browser window.  Exiting JET will not exit WISDM 
and the regular WISDM session timeout rules still apply. 

 

Edit Menu 
 

Menu Command Result 

Undo  (CTRL+Z) If possible, the last operation performed on the grid can be 
undone.  Not all operations are undoable. 

Cut  (CTRL+X) When editing values in the entry grid, you can select text and 
cut it to the clipboard with this command. 

Copy  (CTRL+C) When editing values in the entry grid, you can select text and 
copy it to the clipboard with this command.  

Paste  (CTRL+V) Pastes any text on the clipboard to the current cell being edited. 

Delete Current Line 
(CTRL+SHIFT+DEL) 

Deletes the current line from the grid.  This command can be 
undone. 

Clear All Clears all lines in the entry grid.  Since this command cannot be 
undone, you must confirm your intentions. 

Insert Line  (SHIFT+INS) Inserts a new blank line at the current line position.  This 
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command can be undone. 
 

View Menu 
 

Menu Command Result 

Task Pane  
(CTRL+SHIFT+T) 

Toggles the task pane. 

Errors List  
(CTRL+SHIFT+E) 

Toggles the errors list pane. 

Chart of Accounts 
(CTRL+SHIFT+C) 

Toggles the chart of accounts pane.  If you have a selected line 
in the entry grid, that line's chart of accounts will be loaded. 

View Mode This command opens a submenu that allows you to toggle 
between Transaction mode (single column) or Journal mode 
(two columns for debit and credit). 

Single Line View 
(CTRL+SHIFT+R) 

This will open the single line view dialog.  This dialog is floating 
which means that the dialog will stay open while you work in 
either the main window or in itself.  It provides a synchronized 
top-down view of a line that can be good for hand editing work 
when the grid is too large or cumbersome.  This dialog remains 
open until you close it with the close button. 

Choose Columns This command opens the choose columns dialog that allows 
you to set column visibility.  Use this dialog to set up how 
columns appear in online view and in print outs and exports. 

 
 

 
 
 
 
Journal Menu 
 

Menu Command Result 

Edit Current Line This command will run accounting edits on the current line.  If 
there is no current line, this command is disabled. 

Edit Journal This command runs accounting edits on every line in the 
journal.  This can create a long running process and so status is 
reported in the task pane.  You can cancel this process by 
clicking the cancel button in the status area of the task pane 
while it is running.  If there are no lines in the journal, this 
command is disabled. 

Apply Default Funding This command will invoke a dialog asking for information about 
funding you wish to apply to rows that have errors.  Only after 
edits have run and there are errors will this command be 
available.  The funding string is applied to all rows that have 
errors. 

Check Journal Balance This command will check to see if the journal is balanced 
(amount columns balance to zero).  If this process fails, an error 
is posted in the errors list pane. 

Add Cash Offsets This command will add cash 6100 account offsets to the end of 
the journal.  It is a best practice to run this command last just 
before submission in order to reduce edit checks. 
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Submit to SFS This command will start a series of checks to ensure that the 
journal is valid and then will begin uploading the journal to the 
SFS journal lines table.  This command must re-check edits 
(although it checks only the lines that have not yet passed edits) 
and balance check amongst other things.  If any of these re-
checks fail, the submit process is halted and you must fix any 
errors. 

Check Status This command will open a dialog allowing you to find the status 
of any given journal.  If you are working with a journal, that 
journal's attributes are loaded into the dialog allowing you to 
click Check Status to see its status.  You can also enter the 
attributes yourself to check the status of any journal.  You must 
enter a business unit, a GL Jrnl ID, and a journal date to get a 
status.  The status conveys whether the journal has been 
created in the SFS environment, whether it is pending, or 
posted.  This status can also convey whether the journal is in 
WISDM or not. 

Properties This command will open a dialog that allows you to change the 
header properties of a journal such as the Description and trans 
Ref Number.  This information is carried into SFS upon 
successful submission to SFS.  
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Tools Menu 
 

Menu Command Result 

Tool Snap-ins This isn't a command but a placeholder for the various tools that 
are available to the user.  Many of these tools are dependent on 
the current journal type so this documentation cannot 
enumerate all of them.  In general, a tool "snap-in" is a simple 
routine that can work on a journal or a journal line.  
 
For example, the New Reverse Line tool takes the current 
journal line, reverses the transaction amount and makes a new 
line beneath it.  It is a handy tool for quickly making a new line 
that has the exact same dollar amount as the previous line but 
credited or debited appropriately.  Many tools have quick 
keyboard shortcuts that can make you much more productive.  

Options Opens the options dialog where you can set application 
preferences and options 

 
   

Help Menu 
 

Menu Command Result 

Contents (F1) Opens your default web browser to show this documentation. 

Check for Update Checks the server for a new version of JET that can be 
downloaded.  You will have the option to download and install 
the update right from within JET.  This update check also runs 
each time you start JET.  You should always use the most-
recent version of the software. 

Test Connection Tests to ensure that you can connect to a JET web server.  This 
is for diagnostics purposes only. 

About Displays program title, version, and copyright information.  
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Appendix C: Toolbar Command Reference 
  

This section will explain what each toolbar command does within JET.  After each toolbar name, if 
there is a keyboard shortcut, it is listed in parentheses.  
 

 
 
 

Menu Command Result 

New Journal   Same as the File / New Journal menu command 

Open   
Same as the File / Open menu command 

Save   Same as the File / Save menu command 

Print   Same as the File / Print menu command 

Cut   Same as the Edit / Cut menu command 

Copy   Same as the Exit / Copy menu command 

Paste   Same as the Edit / Paste menu Command 

Undo   Same as the Edit / Undo menu Command 

Journal Properties   Same as the Journal / Properties menu command 

First Line   
Moves the current line marker to the first line of the journal. 

Previous Line   Moves the current line marker back one line, if possible. 

Go to Line   
Type a line number in the text box to go to that line. 

Next Line   Moves the current line marker to the next possible line. 

Last Line   
Moves the current line marker to the last possible line before the 
new line row. 

Add New Line   
Adds a new line to the journal and places focus on that line. 

Delete Line   
Deletes the current line immediately. 

Errors List View Toggle   
Toggles on or off the visibility of the errors list window pane. 

Chart of Accounts View 

Toggle   

Toggles on or off the visibility of the COA window pane. 

View Mode  

 

A mini-drop down menu that allows you to select Transaction or 
Journal mode view. 

 Transaction mode puts all debits and credits in a single 
column, with credits being keyed as a negative amount. 

 Journal mode puts debits and credits in two columns, 
with both being keyed as a positive number. 

Help   Same as Help / Contents menu command 
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Appendix D: JET Error Messages 
  
 

The Journal Entry Tool will display error messages in the errors list pane.  Please refer to the 
following list of messages for an explanation of each.  
 
If you are having problems with any type of error, you can contact the following people in accounting 
services for assistance. 
 

Veronica Olson, Accounting Services at volson@bussvc.wisc.edu 
Al Wang, Accounting Services at awang@bussvc.wisc.edu  

 
 

Error Message Meaning How To Address It 

MSN(E03) DeptID invalid for 
Fund/Project 

The combination of the Department ID, 
fund, and Project ID you are attempting to 
use is not allowed to be used together. 

Verify that you have entered the 
Department ID, fund, and Project ID 
correctly.  Contact your Dean's or 
Director's office to determine what Project 
ID should be used. 

MSN(E04) Program invalid 
for Fund/ProjectID 

The 1 digit Program Code you are trying 
to use is not allowed to be used with your 
project ID and funding source. 

Verify that you have entered the 
Department ID, fund, and Project ID 
correctly.  Contact your Dean’s or 
Director’s office to determine what 
Program codes are allowable with that 
Project ID. 

ORGEDIT: Fund-Program 
invalid for Dept 

The department entered into the funding 
field is not able to use the combination of 
values entered into the Fund and Program 
fields.  Certain departments have specific 
funds that are available to them and that 
can only be used with specific program 
codes. 

Please contact your Dean's Office or 
Division Office for questions regarding 
funding, or contact Veronica Olson at 262-
9460 or volson@bussvc.wisc.edu or Al 
Wang at 262-8729 or 
awang@bussvc.wisc.edu in Accounting 
Services for further assistance. 

Combo not valid as of 
yesterday 

The chartfield combination is violating a 
combo edit rule.   

Contact Susie Maloney in Accounting 
Services at 890-1765 or 
smaloney@bussvc.wiscs.edu. 

Fund Code required Indicates that the fund code chart field 
cannot be blank, empty, or null. 

Use a valid fund code. 

Dept ID required Indicates that the Dept ID chart field 
cannot be blank, empty, or null.  
 

Use a valid Dept ID. 

Program Code required Indicates that the program code chart field 
cannot be blank, empty, or null. 

Use a valid program code. 

Account required Indicates that the account chart field 
cannot be blank, empty, or null.  

Use a valid SFS account code. 

Fund not valid Indicates that the entered fund code chart 
field value is not valid or does not exist in 
the SFS system. 

Verify the fund code is correct. Contact 
your Dean’s office if you think the fund 
code is valid. 

DeptID not valid Indicates that the entered DeptID chart 
field value is not valid or does not exist in 
the SFS system.  

Verify the Dept Id is correct.  Check 
WISDM funding validation 

Project ID not valid Indicates that the entered ProjectID chart 
field value is not valid or does not exist in 
the SFS system. 

Verify the Project ID is correct.  Contact 
your Dean's Office or Division Office for 
questions regarding funding. 

mailto:volson@bussvc.wisc.edu
mailto:awang@bussvc.wisc.edu
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Today’s date (jrnl date) is 
outside proj dates 

Spending is not currently allowed on the 
project ID that has been entered in the 
funding field.  Be sure that the date of the 
invoice is within the project dates and that 
your funding is valid for the fiscal year in 
which the invoice occurred 

Contact your Dean’s or Director’s office to 
determine what Project ID should be 
used. 

Program not valid Indicates that the entered Program Code 
chartfield value is not valid or does not 
exist in the SFS system. 

Check the 1 digit Program Code to verify 
that it is correct.  Contact your Dean's 
Office or Division Office for questions 
regarding funding. 

 

Account not valid Indicates that the entered Account Code 
chartfield value is not valid or does not 
exist in the SFS system. 

Use a valid SFS account code 

Account code is budgetary 
only 

You are trying to use a budget account 
code.  Budget accounts are only valid in 
the standard budget ledger.  

Use a valid SFS account code 

You are not authorized to 
use dept ID 'X' 

Your user account authorizations do not 
allow you to charge to the entered DeptID. 
You must have the privilege to do so or 
pass the journal to a user that does have 
the privileges.  The DeptID may also have 
been entered incorrectly.  

Contact Susie Maloney in Accounting 
Services at 890-1765 or 
smaloney@bussvc.wisc.edu if you have 
questions. Back up e-mail contact is 
Veronica Olson at  
volson@bussvc.wisc.edu . 

Journal is unbalanced Indicates that the journal's debits and 
credits do not equal zero.   

Every journal must balance between 
debits and credits. 

Zero dollar amount used Indicates that the transaction has a 0.00 
dollar monetary amount.  

This is a warning that is raised for your 
convenience to detect journal lines that 
have no influence on the journal balance 
(and thusly cannot have a cash offset 
applied.) 

 

mailto:smaloney@bussvc.wisc.edu
mailto:volson@bussvc.wisc.edu
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Appendix E: Uninstall JET 
 
 

JET Uninstall Instructions: 

 
1. In Windows, navigate to the control panel (available in the Start Menu). 
 
2. Choose Add/Remove Programs. 

 
3. In the list of currently installed programs, look for Journal Entry Tool and click the 

Change/Remove button. 
 

4. A dialog box will appear giving you the option to restore or remove the application.  Check the 
remove button to remove it from your PC and click OK.  The Journal Entry Tool will then be 
removed from your PC. 
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Appendix F: WISDM Password  
 

The user name and password required for JET is your WISDM username, which is different 
from your net id.  The WISDM username starts with “MSN”.  If you are unsure of you 
username, log into WISDM and from the main menu choose, My Profile> Change Password: 
 

 
 
 

The following dialog box will appear showing you your User Name.  You may also change 
your password in this dialog box.   

 
 

 

 

 
 


